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Note: In the lite version, you can not add authors, groups, or additional scaffolds. You should use the Basic or Enhanced version to set-up
your database and then your users can use the lite version to add their ideas to the database.

SIGNING ON

To log into Knowledge Forum: lite version:

http://yourmachinename :port#/kforum
The “Welcome to Knowledge Forum” window appears
along with a KnowledgeForum.jnpl downloaded to your computer.
For your next log-in, you can either type URL address in your
browser again or double-click the KnowledgeForum.jnpl.

. Select a language from the Language drop-down list.
. Select a database from the Databases drop-down list.
. Type your username in the Login field.

g~ W N

. Type your password in the Password field.
6. Click Login.

Knowledge Forum opens to a view.

1. Type your Knowledge Forum URL address in your browser in the format:

860 Welcome to Knowledge Forum!
W KNOWLEDGE FORUA
| [‘English )
Databases [bellyw )'H
Login: ” l
Password:
( Cancel ) | Login

INLP

KnowledgeForum.jnip

View: Sciegee: Flight of Airplanes

View Link
Double click to go

[EJ5cience: Teacher Discussion
[Jan 21,2002-Oct 7, 2002]

(5 Welcome To knowledg;

@x-12 igs
[an 22, 2002°) ,2004]
ledg?

[Jan 13,2002-5ep 12,2007]

—View Title

to view.

Toolbar
See below.

Note
Double click to
read note.

Movie
Double click
to open.

Attachment

shape of the wing
ichard R.
[Oval shaped
Hector H.

@ About flightmoyv

) About airplane construction

Experiment £2

Higher means lower pressure
EFcCE.

[ Wind is a factor

View Headings

~Highlight and
organize selected
objects.

Double click

0 of 21 selected.

o 1 [ wiLinks

to open.
Info Links Shows build-on or
About the view. reference links.
THE TOOLBAR
New Note View Finder

To create a new note To find or create a view

Search
To search the database

Workspace

Assessment Tools Show/Hide Palette

To access third party applets

Help
To get online help

Logout

REEN
= N K

To exit Knowledge Forum

To access your Workspacer

To show or hide the drawing palette.

Although the
toolbar appears
on every view,
some buttons
might not be
available to you
depending on
your user type.
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CREATING A NOTE

1. Click - The New Note window appears. 3. In the File menu, select Save. You will be
2. Complete the basic note features. You do not need prompted for a title for the note and you can
to use every feature when creating a note. The select the view in which this note will appear.
basic note features consist of the note contents, The note icon will be added to the view and the note
problem, scaffolds, and keywords. window will remain open.
Click to access Shows authors and allows Shows connectionsto ~ Shows authors, last date
pull-down menus. you to add co-authors. other notes and views.  modified, and a link to
. \n* Note history.
@ Knowledge Foru ile Edit 5tyle Obje Publish  Wingdows
@06 Mew Note - Marge /L. ]
\ /. 7

{ Mote | Awthors = Connectidfs  Info = HisAbry |

Add scaffold Typglthe
supports: J)iheow Building | Problem / problem.
» Selecta — | a av

(My theory
scaffold from
the Scaffolds CI need to understand

drop-down list| | ({ Newsnformation Type conte
] . < Arrange
« Select a / This theary cannot explain - movies,
scaffold [_ A better theory o attachment
support by [Putting our knowledge togethe notes, and
double-clicking views by

the support, orf ™\ - R dragging a
click the ; e 1 dropping.
Add button. Pa-rh

ota

i \A&d ) | Insert Drawing | Build-on || Ann ) [ Close J
A A
AN Z
Use keywofd tool to Type in keywords.
select keywords in
note contents. Click to insert ~ After the note has Click to create
drawing in note. been saved this will an annotation.

highlight. Click to
create a build-on note.

ATTACHMENTS AND MOVIES

To add movies and attachments (other documents or images) is to drag them from your desktop to a
Knowledge Forum view or note. An image (jpg, png, or gif) can be displayed as an image by using the
Objects pull-down list on the note or view and selecting Show in Place.
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CONNECTING IDEAS

Referencing

A Whole Note

Drag and drop the note icon to reference into the content of the referencing note.

A Part of a Note (Quoting)

Open the referenced note and copy the text you wish to quote, then paste into the content of the
referencing note.

A View

Drag and drop the view icon to reference into the content of the referencing note.

A Web Page

Type the Web link in http:// format in the content of the note.

Build-On

Open a saved note and click the | Build-on | button on the bottom of the note. shape of the wing

ichard R.

A build-on note will open. Add your ideas. When you save the build-on note,
it will be connected to the note it was built on.

Owval shaped
Co-Authors Hector H.
If you are an author of a note, click the - Authers | tab on the top of the note. Add or remove authors to
this note.
Annotate

- E":B Annotation —
Open a saved note and click the | Annotate l button on the bottom of the note. File =

An Annotation window will open. Type in your annotation. When you close and

save it an Annotation icon followed by the name of the author will appear in
the note. y

Rise-Above
From a view, select the notes you want to rise above (including notes from other users) and select
Rise-Above from the Objects pull-down list. A rise-above folder g will appear in the note containing the
notes that were selected. Complete the creation of the new Rise-Above note.

WORKSPACE

Your Workspace is a private space where you can create and edit notes, work on a drawings, add attachments
or movies that are only accessible by you. When you are done working on your ideas, you can add them to
the view to make them accessible to the community by dragging and dropping them from your workspace to
the view.

The Palette button shows and hides the drawing palette. Use this
palette to create a drawing in a view or a note.

You can also drag and drop a jpg, png, or gif from your desktop to a I h || T || d || / || - || - |

view or note, then use the Object pull-down list to Show in Place.
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[\""""" THE VIEW FINDER

) : [ .’ Knowledge Forum File Edit Objects Layout Windows
to access the View Finder. @0 o View Finder .

-| 1. From a view, click

2. Type in the name of the view you want to find or o
Sertby: () Title @ Date Modified () Date Created () Authors

click

3. Drag and drop from the View Finder to a view to
create a view link.

Creating a New View

1. In the View Finder, go to the Edit pull-down list and select New View.

CREATING A VIEW LINK

To create a view link in a view:

* Drag a view icon from the View Finder to a view or from a view to a note.

SEARCH
Search for objects by words, author, title, keyword, date modified or date created.
To perform a search:

1. Check or uncheck the Notes, Views i . Knowledge Forum File Edit Objects Layout Windows

. 3y ’ r -
Attachments, Movies and Drawings ans Search

check boxes to indicate the Search for: [ Notes [ Views [ Attachments [ Movies [ | Drawings

Knowledge Forum objects to search for. e B conains| |
2. Select the initial criterion from the first

Search drop-down list. Sort by: O Title @ Date Modified ) Date Created () Authors

3. Select from the second Search drop-down
list (if applicable).

4. Either type the search term in the text field
or select from the third drop-down list Previous ) ( Next
(if applicable). -

5. Click Search.

-
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SIGNING ON

Welcome to Knowledge Forum
Register for a username...
Language
Database
Ul Mode

Enter a username

Enter a password

To log on to Knowledge Forum:

1. Type your Knowledge Forum URL address in http://yourmachinename:port#/
format in your browser. The “Welcome to Knowledge Forum” window appears.

2. Select a language from the Language drop-down list.

3. Select a database from the Database drop-down list.

4. Choose the Ul Mode, Enhanced, to match this Quick Reference section.
5. Type your username in the Username field.

6. Type your password in the Password field.

7. Click Sign On.
wany. KnowledgeForum. com Knowledge Forum opens to a view.
000 View: Science: Flight of Agplanes —
File Edit Objects View Layout Windows
M . £ N i
enu options E sy S Pl — View Title

View Link 5
Double click to go ||

.2002-an 21,2004]
Welcome To knowledge Forum 4
Uan 19,2002-Sep 12,2007 v

View Headings

to the view. ;

Toolbar 9
See below.

Note/

Double click to
read the note.

Movie——— ||~
Double click

to open. / ) About airplane construction pighet means lower pressure \:'

hape of the wing
hard R.

o

lick to edit title.
Drag and drop
objects to add
to heading,

Hardtoexplin ~ [J}ow pressure and high pressure
TCT.

Attachment: Image
Shown in place.

Experiment #2
Mary M.

2 About flightmov.

Attachment ][ vinks

0 of 21 selected. ———

Double click \
to open. Info Links Shows build-on or

THE TOOLBAR

New Note
To create a new note

New Attachment [

To add an attachment to a view

View Finder
To find or create a view

Workspace
To access your Workspace

Scaffolds
To view, add, or edit scaffolds

Help
To get online help

About the view. reference links.

New View Link
To add a view link to a view

New Movie

To add a movie to a view
Although the

toolbar appears
on every view,
Authors some buttons
To add, or edit authors and groups. might not be
Show/Hide Palette available to you
To show or hide the drawing palette. ~ depending on
Assessment Tools your user type.
To access third party applets

Logout
To exit Knowledge Forum

Search
To search the database
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CREATING A NOTE

1. Click - The New Note window appears. 3. In the File menu, select Save. You will be
prompted for a title for the note and you can

2. Complete the basic note features. You do not need ot - . !
select the view in which this note will appear.

to use every feature when creating a note. The

basic note features consist of the note contents, The note icon will be added to the view and the note
problem, scaffolds, and keywords. window will remain open.
Click to access Shows authors and allows Shows connectionsto ~ Shows authors, last date
pull-down menus. you to add co-authors. other notes and views.  modified, and a link to
Note history.

= New Note - Eric C.
FI|E Edit Style Uhjects Pub\ish Windows

Add scaffold : = - _"” ote Au‘hors | C{}nne«ctlgns | Info |
supports: | S E -
| w Theory Building | Problem -«
* Selecta | > -
scaffold from [y theory

the Scaffolds
drop-down list.

| I::I need to understand

(leyrmnmn

(Thl! theory cannot !xplaln
| (:A better theory

A

* Selecta
scaffold
support by
double-clicking |
the support, or
click the

Putting our knowledge tog

. Parw| rds

X
[-InserIA Drawing ]I Build-on J[ Annotat\\]g Close ]
A S ;

A

Add button.

Use keywofd tool to
select keywords in
note contents. Click to insert After the note has Click to create
drawing in note. been saved this will an annotation.
highlight. Click to
create a build-on note.

Type in keywords.

ATTACHMENTS AND MOVIES

The easiest way to add movies and attachments (other documents or images) is to drag them from
your desktop to a Knowledge Forum view or note. An image (jpg, png, or gif) can be displayed as an
image by using the Objects pull-down list on the note or view and selecting Show in Place.

or . buttons on the toolbar.
To move an existing attachment or movie to a different view or note:
1. Use copy and paste from the File menu to copy the attachment and paste it in the new view or note.

You can also add an attachment or movie using the '

or
2. Drag and drop an attachment or movie icon from a view or note into the content field of your note.

Type conte
Arrange
movies,
attachment
notes, and
views by
dragging a
dropping.
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CONNECTING IDEAS

Referencing

A Whole Note
Drag and drop the note icon to reference into the content of the referencing note.

A Part of a Note (Quoting)

Open the referenced note and copy the text you wish to quote, then paste into the content of the
referencing note.

A View

Drag and drop the view icon to reference into the content of the referencing note.

A Web Page

Type the Web link in http:// format in the content of the note.

Build-On

Open a saved note and click the | Build-on | button on the bottom of the note. shape of the wing

hard R.

A build-on note will open. Add your ideas. When you save the build-on note,
it will be connected to the note it was built on.

Owval shaped
Co-Authors Hector H.
If you are an author of a note, click the - Authoers | tab on the top of the note. Add or remove authors to
this note.
Annotate

- E":B Annotation —
Open a saved note and click the | Annotate l button on the bottom of the note. File =

An Annotation window will open. Type in your annotation. When you close and

save it an Annotation icon followed by the name of the author will appear in
the note. y

Rise-Above

From a view, select the notes you want to rise above (including notes from other users) and select
Rise-Above from the Objects pull-down list. A rise-above folder g will appear in the note containing the
notes that were selected. Complete the creation of the new Rise-Above note.

WORKSPACE

Your Workspace is a private space where you can create and edit notes, work on a drawings, add attachments
or movies that are only accessible by you. When you are done working on your ideas, you can add them to
the view to make them accessible to the community by dragging and dropping them from your workspace to
the view.

The Palette button shows and hides the drawing palette. Use this
palette to create a drawing in a view or a note.

You can also drag and drop a jpg, png, or gif from your desktop to a I h || T || d || / || L] || - |

view or note, then use the Object pull-down list to Show in Place.
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[v™T THE VIEW FINDER

|[I

View Finder

1. From a view, click & to access the View Finder. File Edit Objects Layout Windows

2. Type in the name of the view you want to find or

. > Title @ Date Modified O Date Created () /
click

3. Drag and drop from the View Finder to a view to
create a view link.

Creating a New View

1. In the View Finder, go to the Edit pull-down list and select New View.

CREATING A VIEW LINK
To create a view link in a view:
* Drag a view icon from the View Finder to a view or from a view to a note.

or

1. Click L
2. Select the view to link to from the Choose a view drop-down list.

3. The New View Link window appears.

SEARCH

Search for objects by words, author, title, keyword, date modified or date created.

To perform a search:

Search

1. Check or uncheck the Notes, Views, Edit Objects Layout Windows
Attachments, Movies and Drawings
check boxes to indicate the
Knowledge Forum objects to search for.

otes |_| Views _| Attachments _| Movies

contains carl

2. Select the initial criterion from the first
Search drop-down list. {]ow many are happy?

Carl B. [Feb 26,2001-Feb 27,2001]

3. Select from the second Search drop-down | [[How many are happy?
Carl B. [Feb 26,2001-Feb 27,2001]

list (if applicable). [ More about Quotes

Carl B. [Dec 1,1999-Feb 16,2001

4. Either type the search term in the text field {1 question?
Bereiter C. [Dec 2, 1999-Aug 31,2000]

or select from the third drop-down list [ Quoting other Authors
(|f applicable). Carl B. [Jun & 2002-Jun 8,2002]

‘Quoting other Authors
5. Click Search.

Title () Date Modified () Date Created

Carl B. [Feb 17.2001-0Oct 7.20021

—
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SIGNING ON

Welcome to Knowledge Forum
Rlster for a username...
Language ([EXIENNNNG
Database (LTI
Ul Mode [T

Enter a username

Enter a password

www.KnowledgeForum.com
Credits

View Title

Note
Click to reattnate.

Attachment
Click to open.

Movie
Click to oper

Picture
Click to open:

View Link
Click to go to vie

Toolbar
See below.

THE TOOLBAR

New Note
To create a new note

New Attachment
To add an attachment to a view

View List
To find or create a view

My Reader
To access My Reader

Scaffolds
To view, add, or edit scaffolds

Help
To get online help

B AS1C

R EFERENTCE CARD -

To log on to Knowledge Forum:

1. Type your Knowledge Forum URL address in http://yourmachinename:port#/
format in your browser. The “Welcome to Knowledge Forum” window appears.

2. Select a language from the Language drop-down list.

3. Select a database from the Database drop-down list.

4. Choose the Ul Mode, Basic, to match this Quick Reference section.
5. Type your username in the Username field.

6. Type your password in the Password field.

7. Click Sign On.

Knowledge Forum opens to a view.

View Headings

View: KForumDemo46: New Knowledge Forum Features

Highlight and
organize selected
Purpose of this view editr Background edit 4 .
[B New Features ; Ob]eCtS.

= Knowledge Forum's Origin m
[B Introduction to Headings & About Knowledge Forum o

Heading Sieps
Do Action...

Select option for
displaying notes in
the view.

Search and Notification edit by Scott [2005, May T9

[ Notifications edit by Jill [2005, May 19]

Ml View Sorting Options edit by Scott, Susana [2005, May 19]

& ‘Why Discussion display is betfer edit by Manager [2005, May 19]
Why Table display is better edit by Kirk [2005, May 19]

=] Import Authors edit by Scott [2005, May 19]

[@ Annotation Placement edit by Scott [2005, May 19]

] Creating an Annotation edit by Alan [2005, Jun 13]

B Adding a picture edit by Manager [2005, Jul 27]

The Do Action drop-
down list allows you to
move or clear selected
objects, and create
headings.

] Search Steps edit by Manager [2005, May 19]
B Inroduction o Knowledge Forum edis by Manager [2005, Jun 28]

® About Knowledge Forum _edit by Lennic [2005, Jun 28]
= Knowledge Forum's Origin_ edit by Lennie [2005. Jun 14]

v Do Action...
Add To Reader

Clear Selected

Delete Selected

New Rise-Above Note
New Reference Note
New Heading

Copy To View... 4

[4 Alan's Drawing by Alan [2005, Jul 27]

& Advanced Features edit by presenter, Manager [2002, Jun 13]
Welcome To Knowledge Forum edit by Lennie, presenter, Eric [2005, May 19]

BN D BN ED REEEREEENED g =

New View Link
To add a view link to a view

New Movie

To add a movie to a view
While the toolbar

Search appears on every
To search the database view, some
I;g Em; Authors buttons may not
[ 'l To view, add, or edit authors, be available to

you depending on
your user type.

groups, and registration codes

Applet List

To access third party applets
Logout

To exit Knowledge Forum
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CREATING A NOTE

3. Click Advanced to access the advanced note
1. Click L2, The New Note window appears. features. You do not need to use the advanced
features to create a note. In advanced mode,

you can add co-authors, hide or display image
attachments, and nominate a note for publication.

2. Complete the basic note features. You do not need
to use every feature when creating a note. The
basic note features consist of the Title, In View,
Scaffold, Content, Reference, Keywords, and 4. Click Close and Contribute.

Problem sections. The note appears in read mode as it is added to

the view.

Click to access the advanced note features. Click to save the note and close the window.

New Mote
Type the note’s title. P I Close and Contribute | | Cancel

(Welcame To Knowiedge Forum €————— S@l6ct the view to
add the note to.
* Select a scaffold

from the Scaffolds

drop-down list. < Type content.

My theory

I need to understand
New information
This theory cannot explain

A better theory

Putting our knowledge together

Add scaffold supports:

* Select a scaffold
support from the
Scaffold list box.

 Click Add.

* Type the scaffold
support text in
the Content field
between the >
< symbols of the

scaffold support’s Problem
HTML code. \

\\ ~ oy

|—Select a note,
view, attachment,
or movie to
reference from

the corresponding

T & i
> = L Reference drop-
Attachment [%) [Movie 3] down list

Type the keywords. Type the problem.

<kf:support support="New information" ID="18 =Enter text
here.</kf:support>

REFERENCING

Whole Note Web Page

Select the note to reference from the Note drop-down  Type the Web link in http:// format in the Content field
list in the Reference section of the referencing note. of the note.

Part of a Note (Quoting) Movie Segment

Open the referenced note and copy and paste the Open the movie. Set the start and end points of the
text you wish to quote between the > < symbols in movie segment and click Produce Movie Segment.
the Content field of the referencing note. Copy the movie segment’s HTML code into the

View Content field of the referencing note.

Select the view to reference from the View drop-down = HTML code for each reference will be added to the
list in the Reference section of the referencing note. Content field of your note.
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ATTACHMENTS

CONNECTING IDEAS

In addition to referencing, you can connect ideas in
Knowledge Forum using several different methods.

Rise-Above Note

From a view, check the notes you want to rise above
(including notes from other users) and select New
Rise-Above from the Do Action drop-down list.
Complete the creation of the new rise-above note.

Build-On Note
In read mode, click Build-on in the note you want to
build on. Complete the creation of the build-on note.

To add an attachment to a view:
1. Click =5, The New Attachment
window appears.
2. Type the title in the Title field.

3. Click Choose File. The Open
window appears.

4. Select the file to attach.
5. Click Choose.

6. In the New Attachment window, select the
view to add the attachment to.

7. Click Close and Contribute.
To add a new attachment to a note:

1. Select Create new attachment from the
Attachment drop-down list in the Reference
section. The New Attachment window
appears.

2. Complete the New Attachment window.
3. Click Close and Contribute to save the note.

Create new attachment
Knowledge Building Features:
Knowledge Building
The Evolution of Knowledge Forum
My Attachments:
Knowledge Forum Workshops
MNew Knowledge Building ideas
Adding a Note

Attachment drop-down list

To add an existing attachment to a note:

1. Select an attachment from the Attachment
drop-down list in the Reference section.

2. Click Close and Contribute.

KNOWLEDGE FORUM +« Basic - KNOWLEDGE FORUM - Basic - KNOWLEDGE FORUM

Co-Authors
In advanced mode, add or remove authors from the
Authors section of the note.

Publish
In advanced mode, click the Candidate for
Publication check box.

Annotate
In read mode, click Annotate and type your annotation
in the Annotation field of the New Annotation window.

To add a movie to a view:

1. Click 4®  The New Movie window appears.

2. Type the - New Movie
title in the - ~ov
Title field. | Fmmmm— e o ne s

SN b
Choose - O Stieaming
File next
to the File field. The Open window appears.

4. Select the movie file to attach.
5. Click Choose.

6. In the New Movie window, select the view to
add the movie to.

7. Select the playback option.
8. If you want to add a poster frame:

Click Choose File next to the Poster frame.
The Open window appears.

Select a .jpg file to associate with the
movie. Click Choose.

9. In the New Movie window, click Close
and Contribute.

To add a new movie to a note:

1. Select Create new movie from the Movie
drop-down list in the Reference section. The
New Movie window appears.

2. Complete the New Movie window.
3. Click Close and Contribute to save the note.
To add an existing movie to a note:

1. Select a movie from the Movie drop-down
list in the Reference section.

2. Click Close and Contribute.
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-'_ﬂ CREATING A VIEW LINK
-

To create a view link in a view: 1. Click . The New View Link window appears.

2. Select the view to link to from the Choose a view drop-down list.

From a view, click to access the View List window.

Copy selected view links to My Hotlist or other views by using the Do Action drop-down list.

View List for KForumDemo4_6 Select the type of views

Click the check - to display from the Show
box to select View List: Level 1 Views  Show [EYIENEmE | "=~V pey

drop-down list.

the view link.

.

Click the view Click to create a new view.
link to access

the view.

[ M 53 Headings View 2
@ K-12 Scenarios m

= I= Knowledge Building Features

SEARCHING

Search for objects by text in the object body, author, keyword, note title, view title, problem, scaffold support,
user group, date created, date last modified, unread, references to your notes, and, for editors and managers,
status and accessibility. The initial criterion chosen will determine the remaining Search fields available.

To perform a search:

1 . Check or uncheck the Notes, Views, Attachments, and Movies check boxes to indicate the Knowledge
Forum objects to search for.

2. Select the initial criterion from the first Search drop-down list.
3. Select from the second Search drop-down list (if applicable).
4. Either type the search term in the text field or select from the third drop-down list (if applicable).

5.Click Find. ene Search KForumDemo4_6
Search and Notification
Saved searcheS\ My Searches My Notifications
listed for future use. B Author contains "alan"  deiete 1 Author contains "alan" edit delete
create another natification Set notification in
;'-‘-] Unr.cad by Self and Title contains ) i Unr.cad by Self and Tl[l:mm/order o receive
'search"  delete "search" edir delere . .
create another notification e-mall Wlth updated

= R
Search for ™ Notes & Views # Attachments # Movies where

Increase the

number Of . Author 15} [contains [§) alan
search criteria to
narrow the search. [ Find |
Search Title [Author contains “alan”
Save search criteria.
5
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